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Abstract

The GNOME Accessibility Guide is for users, system administrators, and anyone who is interested in how the
GNOME Desktop supports people with disabilities and addresses the requirements of Section 508 of the U.S.
Rehabilitation Act.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License (GFDL),
Version 1.1 or any later version published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. You can find a copy of the GFDL at this link [ghelp:fdl] or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this manual separately
from the collection, you can do so by adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are claimed as trademarks. Where those names appear
in any GNOME documentation, and the members of the GNOME Documentation Project are made aware of those trademarks, then the
names are in capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED UNDER THE TERMS OF THE GNU FREE
DOCUMENTATION LICENSE WITH THE FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF
THE DOCUMENT IS FREE OF DEFECTS MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING.
THE ENTIRE RISK AS TO THE QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED
VERSION OF THE DOCUMENT IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECT-
IVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF
ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ES-
SENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS AU-
THORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING NEGLIGENCE),
CONTRACT, OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR
OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES,
BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOP-
PAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES OR LOSSES ARISING OUT OF
OR RELATING TO USE OF THE DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY
SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Feedback

To report a bug or make a suggestion regarding the GNOME Desktop or this manual, follow the directions in the GNOME Feedback
Page [ghelp:gnome-feedback].

ghelp:fdl
ghelp:gnome-feedback
ghelp:gnome-feedback




Table of Contents
Preface ................................................................................................................................... viii

Who Should Read This Guide ............................................................................................ viii
How This Guide Is Organized ............................................................................................ viii
Related Documentation ..................................................................................................... viii

1. Introduction to Accessibility ...................................................................................................... 2
Overview of Accessibility ..................................................................................................... 2

2. Configuring the Mouse and Keyboard .......................................................................................... 4
Configuring the Mouse ......................................................................................................... 4

To Configure the Behavior of the Mouse ......................................................................... 4
To Configure the Cursor ............................................................................................... 5
To Use the Keyboard to Emulate the Mouse ..................................................................... 5

Configuring the Keyboard .................................................................................................... 5
To Activate the Keyboard Accessibility Options ............................................................... 6
To Enable the Keyboard to Emulate the Mouse ................................................................. 6
To Enable the Slow Keys Feature ................................................................................... 8
To Enable the Bounce Keys Feature ............................................................................... 8
To Enable the Sticky Keys Feature ................................................................................. 9
To Enable Audible Notifications for Toggle Keys ........................................................... 10
To Enable the Repeat Keys Feature .............................................................................. 10

Using the Keyboard Accessibility Status Panel Application ....................................................... 10
3. Using the Keyboard to Navigate the Desktop .............................................................................. 13

Introduction to Keyboard Navigation .................................................................................... 13
Essential Keyboard Shortcuts ...................................................................................... 13
Global Keyboard Shortcuts ......................................................................................... 13

Navigating the Desktop Background ..................................................................................... 14
Navigating Panels ............................................................................................................. 15

To Move a Panel Object ............................................................................................. 15
To Navigate Drawers ................................................................................................. 16
To Navigate Menus on Panels ..................................................................................... 17
To Navigate Panel Applications ................................................................................... 17

Navigating Your Workspaces .............................................................................................. 17
Navigating Windows ......................................................................................................... 18

To Give Focus to a Window ........................................................................................ 18
To Control a Window ................................................................................................ 18
To Move a Window ................................................................................................... 19
To Resize a Window .................................................................................................. 19
To Navigate Paned Windows ....................................................................................... 20

Navigating Applications ..................................................................................................... 20
Essential Keyboard Shortcuts for Navigating Applications ................................................ 21
Essential Keyboard Shortcuts for Navigating Dialogs ....................................................... 21

Navigating the File Manager ............................................................................................... 22
To Navigate a Folder ................................................................................................. 22
To Navigate Browser Window Components ................................................................... 23

Navigating Help Content in Caret Navigation Mode ................................................................ 23
Navigating Standard Elements and Controls ........................................................................... 24

To Navigate Menus ................................................................................................... 24
To Navigate Buttons .................................................................................................. 24
To Navigate Radio Buttons ......................................................................................... 25
To Navigate Check Boxes ........................................................................................... 25
To Navigate Text Boxes ............................................................................................. 26
To Navigate Spin Boxes ............................................................................................. 27
To Navigate Drop-Down Lists ..................................................................................... 28
To Navigate Drop-Down Combination Boxes ................................................................. 28

GNOME 2.14 Desktop Accessibility Guide

iv



To Navigate Sliders ................................................................................................... 29
To Navigate Tabbed Sections ...................................................................................... 30
To Navigate Lists ...................................................................................................... 31
To Navigate Trees ..................................................................................................... 33

Customizing Your Keyboard Shortcuts .................................................................................. 33
To Customize Keyboard Shortcuts on Solaris Systems ..................................................... 33
To Customize Keyboard Shortcuts on Linux Systems ....................................................... 34

4. Customizing the Appearance of the Desktop ............................................................................... 36
Customization Options ....................................................................................................... 36
Using Themes to Customize the Desktop ............................................................................... 36

Introduction to Themes .............................................................................................. 36
To Choose a Theme ................................................................................................... 37
To Modify the Controls Setting for a Theme ................................................................... 38
To Modify the Window Border Setting for a Theme ........................................................ 38
To Modify the Icon Setting for a Theme ........................................................................ 39
To Create Your Own Themes ...................................................................................... 39

Customizing Specific Components of the Desktop ................................................................... 39
To Customize the Desktop Background ......................................................................... 39
To Customize Desktop Background Objects ................................................................... 39
To Customize Fonts ................................................................................................... 40

Meeting Specific Accessibility Needs ................................................................................... 41
To Achieve a High or Low Contrast Desktop .................................................................. 41
To Achieve a Large Print Desktop ................................................................................ 41

5. Using the Assistive Technologies .............................................................................................. 44
On-Screen Keyboard ......................................................................................................... 44

Maximizing Application Windows for On-Screen Keyboard Users ..................................... 44
Screen Reader and Magnifier ............................................................................................... 44
Disabling the Screensaver ................................................................................................... 45

A. System Administration ........................................................................................................... 46
Configuring the Desktop for Accessible Login ........................................................................ 46

To Enable Accessible Login ........................................................................................ 46
To Start Assistive Technologies at Login ....................................................................... 48
Additional Requirements for Accessible Login ............................................................... 50

Configuring the Java Environment for Accessibility on Solaris Systems ...................................... 50
Enabling XKB on Solaris Systems ........................................................................................ 51
Enabling Full Screen Magnification ...................................................................................... 52

To Enable Full Screen Magnification Using Two Video Cards ........................................... 52
To Enable Full Screen Magnification Using One Video Card on Linux Systems .................... 52

Enabling Braille ................................................................................................................ 53
To Enable Braille on Solaris Systems ............................................................................ 53
To Enable Braille on Linux Systems ............................................................................. 54

Configuring Alternative Pointer Devices ................................................................................ 54
To Configure Alternative Pointer Devices on Solaris Systems ............................................ 54
To Configure Alternative Pointer Devices on Linux Systems ............................................. 55
To Configure On-Screen Keyboard to Use an Alternative Pointer Device ............................. 56

Index ...................................................................................................................................... 57

GNOME 2.14 Desktop Accessibility Guide

v



List of Figures
3.1. Sample Button .................................................................................................................... 24
3.2. Sample Radio Button ........................................................................................................... 25
3.3. Sample Check Box .............................................................................................................. 25
3.4. Sample Single Line Text Box ................................................................................................ 26
3.5. Sample Spin Box ................................................................................................................ 27
3.6. Sample Drop-Down List ....................................................................................................... 28
3.7. Sample Drop-Down Combination Box .................................................................................... 28
3.8. Sample Slider ..................................................................................................................... 29
3.9. Sample Dialog with Tabbed Sections ...................................................................................... 30
3.10. Sample Tree Structure ........................................................................................................ 33

GNOME 2.14 Desktop Accessibility Guide

vi



List of Tables
2.1. Numeric Keypad to Mouse Function Mapping ............................................................................ 7
2.2. Function Key to Mouse Function Mapping on Solaris Systems ...................................................... 7
2.3. Sticky Keys Latch or Lock Mode ............................................................................................. 9
2.4. Keyboard Accessibility Status Icons ....................................................................................... 10
4.1. Quick Reference to Customizing the Appearance of the Desktop .................................................. 36
4.2. Themes Designed for Accessibility Requirements ...................................................................... 37
4.3. Controls Options Designed for Accessibility Requirements ......................................................... 38
4.4. Icon Options Designed for Accessibility Requirements ............................................................... 39

GNOME 2.14 Desktop Accessibility Guide

vii



Preface
The GNOME 2.10 Desktop Accessibility Guide describes how to configure, customize, and use the accessibility fea-
tures of the GNOME 2.10 Desktop.

Who Should Read This Guide
This guide is for users, system administrators, and anyone who is interested in how the GNOME 2.14 Desktop sup-
ports people with disabilities and addresses the requirements of Section 508 of the U.S. Rehabilitation Act.

How This Guide Is Organized
This guide is structured in the following manner:

• Chapter 1, Introduction to Accessibility introduces you to accessibility in the GNOME Desktop.

• Chapter 2, Configuring the Mouse and Keyboard describes how to configure the mouse and keyboard to make
these devices accessible to more users.

• Chapter 3, Using the Keyboard to Navigate the Desktop describes how to navigate the GNOME Desktop from
the keyboard.

• Chapter 4, Customizing the Appearance of the Desktop describes the methods you can use to change the appear-
ance of the GNOME Desktop to enhance the accessibility of the desktop for users with visual impairments.

• Chapter 5, Using the Assistive Technologies introduces you to the assistive technologies that are available from
the GNOME Desktop.

• Appendix A, System Administration describes the system administrator tasks that you need to perform before
you can use the assistive technologies for the GNOME Desktop.

Related Documentation
The following manuals are related to this guide:

• GNOME 2.10 Desktop System Administration Guide

• GNOME 2.10 Desktop User Guide

Preface
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This chapter introduces you to accessibility in the GNOME Desktop.

Overview of Accessibility
All software products should incorporate accessibility features to enable people with disabilities to use the software
easily and efficiently. Recent legislation such as Section 508 of the U.S. Rehabilitation Act heightens awareness of
the need to provide accessible software.

The GNOME Desktop is easy to use and incorporates many accessibility features. Every supported application and
utility in the GNOME Desktop is designed with accessibility and usability in mind. Users with physical disabilities
such as low vision or impaired motor skills can use all of the functionality of the GNOME Desktop thanks to the
customization tools that are available. The customization tools enable you to customize the appearance and behavior
of the desktop.

The ability to easily customize the GNOME Desktop contributes greatly to the accessibility of the desktop. This
guide describes the various customization options that you can use to tailor the desktop to suit your particular needs.
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This chapter describes how to configure the mouse and keyboard to make these devices accessible to more users.

Configuring the Mouse
Use the Mouse preference tool to configure the mouse to suit your needs. To open the Mouse preference tool,
choose Desktop→Preferences→Mouse. The Mouse Preferences dialog is displayed.

To Configure the Behavior of the Mouse
The following sections describe how to modify the behavior of the mouse to suit your needs.

To Configure the Mouse for Left-Handed Use

To configure the mouse for left-handed use, click on the Buttons tab in the Mouse Preferences dialog, then select the
Left-handed mouse option. When you select this option, the system swaps the functions of the left mouse button and
the right mouse button immediately.

To Configure the Double-Click Behavior

If you have difficulty double-clicking, you can increase the period of time that the system allows to elapse between
the first click and the second click of a double-click. For example, if the double-click timeout setting is 0.4 seconds,
you must perform the second click of a double-click within 0.4 seconds of the first click. If the second click occurs
more than 0.4 seconds after the first click, the system interprets the two clicks as two single clicks.

To configure the double-click timeout setting, perform the following steps:

1. Click on the Buttons tab in the Mouse Preferences dialog.

2. Use the Timeout slider to specify the timeout in seconds that the system allows between the two clicks of a
double-click. Moving the slider to the right will increase the timeout interval in 0.1 second intervals. In the
same manner, moving the slider to the left will decrease the timeout in 0.1 second intervals.

3. Double-click on the light bulb to the right of the slider to test the setting. If you perform the two clicks of the
double-click within the timeout specified, the light bulb lights up fully to display a yellow glow around the
bulb. If you do not double-click within the timeout specified, the light bulb does not light fully. You should in-
crease the timeout setting and try again. When the light bulb lights, the timeout setting is suitable for your
needs.

To Change the Size of the Mouse Pointer

To change the size of the mouse pointer that is displayed on the desktop, perform the following steps:

1. Click on the Pointers tab in the Mouse Preferences dialog.

2. This will display a list of pointer themes and sizes available.

3. By default, GNOME does not include mouse pointer themes. Information about installing and using pointer
themes can be found in the User Guide [ghelp:user-guide?goscustdesk-54].

On some platforms you must log out and log in again for this setting to take effect.

To Locate the Mouse Pointer

If you have difficulty locating the mouse pointer on the screen, you can enable an option to highlight the pointer
when you press the Control key. To enable this option, click on the Pointers tab in the Mouse Preferences dialog,

Chapter 2. Configuring the Mouse and Keyboard Configuring the Mouse

4

ghelp:user-guide?goscustdesk-54


then select the Highlight the pointer when you press Ctrl option. When you press Control, the system displays an
animation around the pointer to highlight the pointer.

On some platforms, you must log out and log in again before this setting takes effect.

To Configure the Speed and Sensitivity of the Mouse

To configure the speed and sensitivity of the mouse, perform the following steps:

1. Click on the Motion tab in the Mouse Preferences dialog.

2. Configure the following options:

Acceleration
Use the slider to specify the speed at which the mouse pointer moves around the screen when you move your
mouse.

If you select a low setting, the mouse pointer moves at a speed similar to the speed at which you are physically
moving the mouse. This means that you need to physically move the mouse larger distances to cover the screen
area. If you select a high setting, the mouse pointer moves at a faster speed than the speed at which you physic-
ally move the mouse. This means that you need to physically move the mouse small distances to cover the
screen area.

Sensitivity
Use the slider to specify how responsive the mouse pointer is to movements of your mouse. Moving the slider
to the right will increase the sensitivity and moving it to the left will decrease the sensitivity.

Threshold
Use the slider to specify the distance that you must move an item before the system interprets the move action
as a drag-and-drop action.

To Configure the Cursor
The following section describes how to modify the display characteristics of the cursor.

To Stop the Cursor Blinking

To stop the cursor blinking in text boxes and fields, perform the following steps:

1. Choose Desktop→Preferences→Keyboard to start the Keyboard preference tool.

2. In the Keyboard tabbed section, deselect the Cursor blinks in text boxes and fields option.

To Use the Keyboard to Emulate the Mouse
If you have difficulty using a mouse, you can use the keyboard to emulate the mouse functions. See the section
called “To Enable the Keyboard to Emulate the Mouse” of this guide for more information.

Configuring the Keyboard
Use the Keyboard preference tool, to configure the keyboard accessibility options. To open the Keyboard preference
tool, choose Desktop→Preferences→Keyboard. Accessibility options can be enabled by selecting Accessibility.
This will open a new dialog, Keyboard Accessibility Preferences, also known as AccessX.

Chapter 2. Configuring the Mouse and Keyboard Configuring the Keyboard
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Before you can use the Keyboard Accessibility preference tool on Solaris systems, you must follow the
steps outlined in the section called “Enabling XKB on Solaris Systems” of this guide.

The Keyboard Accessibility Preferences (AccessX) dialog enables you to customize your keyboard in the following
ways:

• To use the numeric keypad to emulate mouse actions. See the section called “To Enable the Keyboard to Emu-
late the Mouse”.

• To specify the duration for which you must press-and-hold a key before the system accepts the keypress. See the
section called “To Enable the Slow Keys Feature”.

• To ignore rapid, repeated keypresses of the same key. See the section called “To Enable the Bounce Keys Fea-
ture”.

• To accept key combinations in sequence rather than simultaneously. See the section called “To Enable the Sticky
Keys Feature”.

• To emit an audible notification when a user activates or deactivates a toggle key. See the section called “To En-
able Audible Notifications for Toggle Keys”.

• To ignore long keypresses of the same key and control the repeat rate of a keypress. See the section called “To
Enable the Repeat Keys Feature”.

To Activate the Keyboard Accessibility Options
To activate the keyboard accessibility options, perform the following steps:

1. Choose Desktop→Preferences→Keyboard and select Accessibility

2. Select the Enable keyboard accessibility features option.

3. Click on the Basic tab.

4. Select the Beep when features turned on or off from keyboard option to receive an audible notification each
time a user enables or disables a keyboard accessibility option using the following keyboard shortcuts:

• Press-and-hold Shift for eight seconds to enable or disable the slow keys feature.

• Press Shift five times to enable or disable the sticky keys feature.

5. To automatically disable the keyboard accessibility options if the options are not used for a specified number of
seconds, select the Disable if unused for X seconds option. Use the slider to specify the number of seconds of
keyboard idle time required before the system disables the keyboard accessibility options.

This option is intended for computers that are shared by a number of different users, some of whom require the
keyboard accessibility options.

6. Changes made will be instantly applied.

To Enable the Keyboard to Emulate the Mouse
The mouse keys feature enables you to use the numeric keypad on the keyboard to emulate mouse actions. This fea-
ture benefits users who have difficulty using a mouse or other pointing device. To enable and configure the mouse
keys feature, perform the following steps:

1. In the Keyboard Accessibility Preferences (AccessX) dialog, select the Mouse Keys tab.

2. Select the Enable Mouse Keys option.

3. Configure the following options to determine the behavior of the mouse pointer when you control the pointer
from the numeric keypad:
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Maximum pointer speed
Use this spin box to specify the maximum speed, in pixels per second, at which the pointer moves around the
screen.

Time to accelerate to maximum speed
Use this spin box to specify the duration, in milliseconds, before the pointer accelerates to the maximum pointer
speed.

Delay between keypress and pointer movement
Use this spin box to specify the interval, in milliseconds, between a keypress and the time when the pointer
starts to move.

When you enable mouse keys, the keys on the numeric keypad have the following functions:

Table 2.1. Numeric Keypad to Mouse Function Mapping

Numeric Keypad Keys Function

1, 2, 3, 4, 6, 7, 8, 9 Move the mouse pointer around the screen

5 Mouse button click

0 Mouse button toggle

/ Primary mouse button

* Secondary mouse button

- Tertiary mouse button

The toggle mouse button key enable the currently selected mouse button until the Mouse button click key is pressed.
This allows you to perform drag and drop operations.

The Mouse button click emulates the currently selected mouse button. Pressing /, * or - will change the behaviour of
this. The currently selected mouse button can be seen in the Keyboard Accessibility Status panel application, dis-
cussed in the section called “Using the Keyboard Accessibility Status Panel Application”.

The Primary mouse button is the left mouse button for right handed people. The Secondary mouse but-
ton is the right mouse button and the Tertiary mouse button is the middle mouse button.

Some Solaris systems also use the function keys to emulate the mouse buttons. The common function key to mouse
button mappings are described in the following table.

Table 2.2. Function Key to Mouse Function Mapping on Solaris Systems

Function Key Function

F2 Mouse button 1

F3 Mouse button 2
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Function Key Function

F4 Mouse button 3

To Enable the Slow Keys Feature
The slow keys feature enables you to customize how the keyboard handles user input in the following ways:

• Specify the duration for which you must press-and-hold a key before the system accepts the keypress. This as-
pect of the feature benefits users who frequently press keys that they do not intend to press.

• Enable audible indications of keyboard input and acceptance. This aspect of the feature benefits users who can-
not see the result of a keypress.

To enable and configure the slow keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) dialog, select the Filters tab.

2. Select the Enable Slow Keys option.

To select or deselect the slow keys feature from the keyboard, press-and-hold Shift for eight
seconds. This will present a dialog confirming that you with slow keys enabled. The Shift key-
board shortcut automatically selects all of the slow keys options. If you selected the Beep when
features turned on or off from the keyboard option in the Basic tab, after four seconds the system
beeps three times to indicate that the system is about to select or deselect the feature.

3. Use the Only accept keys held for slider or spin box to specify the duration, in milliseconds, for which you
must press-and-hold a key before the system accepts the keypress. Use the Type to test settings text box to test
the slow keys setting and modify the setting as required.

4. To enable audible indications of keyboard input and acceptance, select the following options:

Beep when key is pressed
Select this option to hear a beep when you press a key.

Beep when key is accepted
Select this option to hear a beep when the system accepts a keypress.

Beep when key is rejected
Select this option to hear a beep when the system rejects a keypress. The system rejects a keypress if you do not
press-and-hold the key for the duration that is specified in the Only accept keys held for spin box.

To Enable the Bounce Keys Feature
The bounce keys feature enables you to customize the keyboard to ignore rapid, repeated keypresses of the same
key. For example, users with impaired motor skills might press the same key several times when they intend to press
the key once. This feature enables you to customize the keyboard to ignore repeated keypresses.

To enable and configure the bounce keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) dialog select the Filters tab.

2. Select the Enable Bounce Keys option.

3. Use the Ignore duplicate keypresses within slider or spin box to specify the duration in milliseconds (ms) after
the first keypress for which the system ignores repeated keypresses of the same key. For example, if you select
a duration of 500 ms, the system ignores all repeated keypresses of the same key that occur within 500 ms of
the first keypress.
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4. Select the Beep if key is rejected option to hear an audible indication when the system ignores a key.

If you want to enable the bounce keys feature, ensure that the Enable Slow Keys option is deselected.
The slow keys feature requires you to press a key for a specified duration before the system accepts the
keypress as a valid keypress. If you cannot press the key for the duration that is specified by the slow
keys setting, deselect the Enable Slow Keys option to enable the system to accept your input.

To Enable the Sticky Keys Feature
The sticky keys feature enables you to press the keys in a key combination in sequence rather than simultaneously.
This feature is designed for users who are unable to press two or more keys simultaneously.

To enable and configure the sticky keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) select the Basic tab.

2. Select the Enable Sticky Keys option.

To enable the sticky keys feature from the keyboard, press Shift five times. This will present a
dialog confirming that you with to enable sticky keys. The Shift keyboard shortcut automatically
selects all of the sticky keys options. If you selected the Beep when features turned on or off from
the keyboard option, the system beeps to indicate that the system is about to select or deselect the
feature. When active, pressing shift five times in a row will present a dialog asking if you want to
disable sticky keys.

3. Select the Beep when modifier is pressed option to receive an audible indication each time you press a modifier
key such as Ctrl, Alt, or Shift. This option is useful to remind you whether a modifier key is active or inactive.

4. Selecting the Disable if two keys pressed together option will present a dialog with the option to disable sticky
keys if two keys are pressed at the same time.

You can use the sticky keys feature in latch or lock mode. The following table describes how to choose a mode and
the difference between the two modes.

Table 2.3. Sticky Keys Latch or Lock Mode

To use the sticky keys feature in... Press the modifier key... The modifier key remains active
until...

Latch mode Once. You press a non-modifier key.

Lock mode Twice in quick succession. You press the modifier key again.

Example 1: If you want to press Alt-F1, do the following:

1. Press Alt to latch the modifier key. The Alt key remains active.

2. Press F1. The key combination is now complete. After you press F1, the Alt modifier key is no longer active.

Example 2: If you want to press Ctrl-Alt-Tab, do the following:

1. Press Ctrl twice to lock the modifier key. The Ctrl key remains active.

2. Press Alt.
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3. Press Tab. The key combination is now complete.

4. To unlock the modifier key, press Ctrl again.

To Enable Audible Notifications for Toggle Keys
A toggle key is any key on the keyboard that can switch between two states. The Num Lock, Caps Lock, and
Scroll Lock keys are toggle keys. Most toggle keys have an associated light emitting diode (LED) on the keyboard
that lights when the toggle key is active. To assist users with visual impairments, you can customize the keyboard to
emit an audible notification when a user presses a toggle key. For example, when you press Num Lock, you can de-
termine whether the key is toggled or not toggled by the sound that the keyboard emits.

To enable accessible toggle keys, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccesX) select the Filters tab.

2. Select the Enable Toggle Keys option.

When you activate the Num Lock, Caps Lock, or Scroll Lock keys, the system beeps once. When you deactivate a
toggle key, the system beeps twice.

To Enable the Repeat Keys Feature
The repeat keys feature enables you to repeat a keystroke multiple times without pressing the key more than once.
This feature is designed for users who cannot release keys quickly, for example users who operate a mouth stick.
When you enable repeat keys, you can specify the duration for which you must press a key before the key starts to
repeat.

To enable and configure the repeat keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) select the Basic tab.

2. Select the Enable Repeat Keys option.

3. Use the Delay slider or spin box to specify the duration for which you must press a key before the keyboard in-
terprets the action as a repeat key. If you have difficulty releasing keys, select a long time delay.

4. Use the Speed slider or spin box to specify the speed at which the keyboard repeats the keypress as input.

Using the Keyboard Accessibility Status Panel
Application
The Keyboard Accessibility Status panel application shows you the status of the keyboard accessibility features.
This panel application displays icons to indicate which keyboard accessibility features are enabled in the Keyboard
Accessibility preference tool.

To add the Keyboard Accessibility Status panel application to a panel, right-click on the panel, then choose Add to
Panel and select the Keyboard Accessibility Status.

The following table describes the icons that the panel application displays and the status that each icon represents.

Table 2.4. Keyboard Accessibility Status Icons

Icon Keyboard Accessibility Status
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Icon Keyboard Accessibility Status

Keyboard accessibility in general is available but none of the individual key features are
enabled.

The bounce keys feature is enabled.

The mouse keys feature is enabled. The dot in the mouse button shows which button is
currently associated with the Mouse button click key.

The slow keys feature is enabled.

The sticky keys feature is enabled and the Alt key is latched.

The sticky keys feature is enabled and the Alt key is locked.

The sticky keys feature is enabled and the Ctrl key is latched.

The sticky keys feature is enabled and the Ctrl key is locked.

The sticky keys feature is enabled and the Shift key is latched.

The sticky keys feature is enabled and the Shift key is locked.

The sticky keys feature is enabled and the Super/Windows key is latched.

The sticky keys feature is enabled and the Super/Windows key is locked.
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This chapter describes how to navigate the GNOME Desktop from the keyboard only. Users who have difficulty us-
ing a mouse or other pointing device can navigate and use the desktop from the keyboard.

Introduction to Keyboard Navigation
This section describes the essential keyboard shortcuts to enable you to navigate the desktop from the keyboard.

You can customize some of the keyboard shortcuts that are described in this chapter. The text indicates the shortcuts
that you can customize. See the section called “Customizing Your Keyboard Shortcuts” for information about how
to customize keyboard shortcuts.

Essential Keyboard Shortcuts
The following table lists the essential keyboard shortcuts that you can use to navigate the desktop. The keyboard
shortcuts that you use to navigate specific elements and controls are described in the appropriate sections of this
chapter.

Keys Function

Tab Give focus to the next element or control.

Shift-Tab Reverse the navigation direction and give focus to the previous
element or control. In general, the Shift key reverses the naviga-
tion direction.

Ctrl-Tab Give focus to the next element or control, if the Tab key has a
specific purpose in a control. For example, if you press Tab in a
text box, the system inserts a tab space.

To give focus to the previous element or control, press
Shift-Ctrl-Tab.

arrow keys Navigate within an element or control.

spacebar Activate the element or control that has focus. For example, if
the current control is a button, this action is the equivalent of
clicking on the button with a mouse.

Esc Close a window, menu, or drawer.

F7 Switch to caret navigation mode. Caret navigation mode enables
you to use the keyboard to select text. For more information
about caret navigation mode, see the section called “Navigating
Help Content in Caret Navigation Mode”.

Global Keyboard Shortcuts
The following table lists the keyboard shortcuts that you can use from any part of the GNOME Desktop.

Keys Function

Alt-F1 Open the Main Applications Menu.
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Keys Function

You can customize this keyboard shortcut.

Alt-F2 Open the Run Application dialog.

You can customize this keyboard shortcut.

Print Screen Start the screenshot application and take a screenshot of the en-
tire screen.

You can customize this keyboard shortcut.

Alt-Print Screen Start the screenshot application and take a screenshot of the win-
dow that currently has focus.

You can customize this keyboard shortcut.

F1 If the focused element is an application window or dialog, this
keyboard shortcut opens the Help for the application.

Ctrl-F1 If the focused element is a panel or application window, this
keyboard shortcut switches the display of tooltips for the win-
dow or panel objects on and off.

Shift-F10 Open a popup menu for the element that has focus, if a popup
menu exists.

Navigating the Desktop Background
The desktop background is the part of the GNOME Desktop where there are no interface items or applications, such
as panels and windows. The following table lists the keyboard shortcuts that you can use to navigate the desktop
background and the desktop background objects. A desktop background object is an icon on the desktop background
that you can use to open files, folders, or applications.

Keys Function

Ctrl-Alt-D Temporarily hide all windows and give focus to the desktop
background.

To restore the windows, press Ctrl-Alt-D again.

You can customize this keyboard shortcut.

Ctrl-Alt-Tab Display a popup window with icons that represent the desktop
background and the panels. Press-and-hold Ctrl-Alt and contin-
ue to press Tab to switch the focus between the desktop back-
ground and the panels.

You can customize this keyboard shortcut.

arrow keys When the desktop background or a desktop background object
has focus, give focus to a neighboring desktop background ob-
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Keys Function

ject.

A sequence of characters that matches the first n
characters of a desktop background object name.

When the desktop background has focus, give focus to the
desktop background object whose name starts with the specified
sequence of characters.

F2 Rename the desktop background object that has focus.

Shift-F10 Open the popup menu for the desktop background object that
has focus.

Ctrl-F10 Open the Desktop Background menu.

Navigating Panels
A panel is an area from which you can run special programs, applications, and panel applications. The most com-
mon panel is the panel that stretches the full width of the bottom edge of the desktop. The following table lists the
keyboard shortcuts that you can use to navigate panels and panel objects.

Keys Function

Ctrl-Alt-Tab Give focus to a panel. This keyboard shortcut displays a popup
window with icons that represent the desktop background, pan-
els, and drawers. Press-and-hold Ctrl-Alt and continue to press
Tab to switch the focus between the desktop background, pan-
els, and drawers.

You can customize this keyboard shortcut.

Tab Give focus to the next object on the panel.

F10 Open the Applications menu when the Menu Panel has focus.
Continue to press F10 to switch focus between the Applications
menu and the window list.

spacebar Activate a panel object, for example, open a menu or start a
launcher.

Shift-F10 Open the panel object popup menu.

Ctrl-F10 Open the panel popup menu.

To Move a Panel Object
You can move a focused panel object to a different location on a panel or drawer, or you can move the object to the
next panel. To move a panel object, perform the following steps:

1. Press Tab to give focus to the object.
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2. Press Shift-F10 to open the panel object popup menu.

3. Use the arrow keys to select the Move menu item.

4. Use the keyboard shortcuts that are listed in the following table to perform the move operation.

Keys Function

arrow keys Move the object left and right on a horizontal panel or up and
down on a vertical panel.

Shift + arrow keys Move the object and push any objects that you encounter in front
of the object.

Ctrl + arrow keys Move the object and swap position with any objects that you en-
counter in the move.

Tab Move the object to the next panel.

spacebar Complete the move operation.

The following examples demonstrate the effect of different move operations on the objects in a panel.

Illustration Description

Shows a panel with three panel objects before a move operation
takes place.

Shows the effect of using the arrow keys to move the Geyes
panel application on the panel. You can use the arrow keys to
move the panel application left or right until you meet the next
panel object.

Shows the effect of using using Shift + arrow keys to move the
Geyes panel application on the panel. You can use the Shift +
arrow keys to push the Volume Control and Help panel objects
ahead of the object that you are moving.

Shows the effect of using Ctrl + arrow keys to move the Geyes
panel application on the panel. You can use the Ctrl + arrow
keys to swap position with the Volume Control and Help panel
objects as you meet the objects.

Panel applications that are Locked cannot be moved. To unlock a panel application, use the panel ob-
ject menu and unselect Lock to Panel.

To Navigate Drawers
A drawer is a collapsible extension of a panel. The following table lists the keyboard shortcuts that you can use to
navigate into and out of drawers. When you open a drawer, you can navigate the contents of the drawer in the same
way as you navigate a panel. See the section called “Navigating Panels” for information about how to navigate a
panel.
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Keys Function

spacebar Open or close the drawer that has focus.

arrow keys Navigate into the drawer that has focus.

Esc Close the drawer and give focus to the drawer object on the pan-
el.

To Navigate Menus on Panels
The following table lists the keyboard shortcuts that you can use to navigate menus on panels.

Keys Function

spacebar Open the menu that has focus.

arrow keys Navigate the menu.

spacebar Select a menu item.

Shift-F10 Open the popup menu associated with a menu item, if one exists.

Esc Close a menu.

To Navigate Panel Applications
A panel application is a small application that resides on a panel. You can navigate to all panel applications and
open the panel application popup menu from the keyboard. However, if the panel application does not contain con-
trols that you can give focus to, you cannot navigate the controls in the panel application. The following table lists
the keyboard shortcuts that you can use to navigate panel applications.

Keys Function

spacebar Activate the panel application control that has focus, if applic-
able. Not all panel applications contain controls that you can ac-
tivate. If the panel application does not contain a control that
you can activate, the spacebar does nothing.

arrow keys Navigate the controls on the panel application.

Shift-F10 Open the panel application popup menu. To navigate the menu,
use the standard keyboard shortcuts for navigating menus. See
the section called “To Navigate Menus” for information about
how to navigate menus.

Navigating Your Workspaces
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A workspace is a discrete area in which you can work. You can have many workspaces on your desktop and you can
switch from one workspace to another. Each workspace can contain different windows and processes. The following
table lists the keyboard shortcuts that you can use to navigate workspaces.

Keys Function

Ctrl-Alt + arrow keys Give focus to the next or previous workspace. This keyboard
shortcut displays a popup window with icons that represent the
workspaces. Press and hold Ctrl-Alt and continue to press the
arrow keys to switch the focus between the workspaces.

You can customize this keyboard shortcut.

Ctrl-Shift-Alt + arrow keys Move the window that has focus to the next or previous work-
space.

You can customize this keyboard shortcut.

Navigating Windows
The following sections describe the keyboard shortcuts that you can use to navigate windows. A window is a rectan-
gular frame on your screen that displays an application.

You can customize all of the keyboard shortcuts that are associated with navigating windows. See the
section called “Navigating Your Workspaces” for more information.

To Give Focus to a Window
Before you can use or modify a window, you must give focus to the window. The following table lists the keyboard
shortcuts that you can use to give focus to a window.

Keys Function

Alt-Tab Display a popup window with icons that represent each window.
Press-and-hold Alt and continue to press Tab to move through
the windows until you reach the window to which you want to
give focus.

Alt-Esc Raise each window in turn until you reach the window to which
you want to give focus.

To Control a Window
When a window has focus, you can perform various actions on the window. The following table lists the keyboard
shortcuts that you can use to control the window that has focus.

Keys Function
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Keys Function

Alt-spacebar Open the Window Menu.

Alt-F4 Close the window.

Solaris: Open

Linux:Alt-F9

Minimize the window.

Alt-F10 Maximize the window.

Alt-F5 Restore a maximized window to the original size of the window.

To Move a Window
When a window has focus, you can move the window around the screen. The following table lists the keyboard
shortcuts that you can use to move a window.

Keys Function

Alt-F7 Start the move operation. The mouse pointer changes to a cross.

arrow keys Move the window 10 pixels at a time in the direction of the ar-
row key.

Ctrl + arrow keys Move the window one pixel at a time in the direction of the ar-
row key.

Shift + arrow keys Move the window in the direction of the arrow key to align it
with the edge of the nearest window, panel, or screen edge.

spacebar Complete the move operation and leave the window in the cur-
rent position.

Esc Cancel the move operation and restore the window to the origin-
al position.

To Resize a Window
When a window has focus, you can increase or decrease the size of the window. The following table lists the key-
board shortcuts that you can use to resize the window that has focus.

Keys Function

Alt-F8 Start the resize operation.

arrow keys Resize the window in the direction of the arrow keys.

spacebar Complete the resize operation and leave the window at the cur-
rent size.
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Keys Function

Esc Cancel the resize operation and restore the window to the origin-
al size.

To Navigate Paned Windows
A paned window is a window that is split into two or more panes. The Help browser is an example of an application
that uses paned windows.

The following table describes the keyboard shortcuts that you can use to navigate windows with panes.

Keys Function

F6 Give focus to the next pane. The system gives focus to the con-
trol that last had focus in the pane.

F8 Give focus to the first resize handle in the window. The resize
handle is displayed between the panes and enables you to resize
the panes. Press F8 again to give focus to the next resize handle.

When the resize handle has focus, you can use the keyboard shortcuts that are listed in the following table to modify
the paned window.

Keys Function

arrow keys Move the resize handle by a small amount.

Ctrl + arrow keys Move the resize handle by a large amount.

Home Reduce the size of the pane to the left of the resize handle for
vertical panes, or above the resize handle for horizontal panes, to
the minimum size allowed.

End Increase the size of the pane to the left of the resize handle for
vertical panes, or above the resize handle for horizontal panes, to
the maximum size allowed.

spacebar Set the position of the resize handle and return the focus to the
last control that had focus.

Esc Reset the position of the resize handle to the original position
and return the focus to the last control that had focus.

Navigating Applications
An application is any program, utility, or other software package that you run on your desktop. Applications com-
prise the following standard user interface components:
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Windows
A window is a rectangular frame on your screen that displays an application. See the section called “Navigating
Windows” for information about how to navigate windows.

Dialogs
A dialog is a popup window in which you enter information or commands. See the section called “Essential
Keyboard Shortcuts for Navigating Dialogs” for information about how to navigate dialogs.

Controls
A control is an instrument that you use to operate or guide the user interface. For example, buttons, check
boxes, menus, and text boxes are controls. See the section called “Navigating Standard Elements and Controls”
for detailed information about how to navigate the different types of controls that are available.

This section of the manual describes the essential keyboard shortcuts that you can use to start using applications and
dialogs.

Essential Keyboard Shortcuts for Navigating Applications
Since there are many applications that you can use in the GNOME Desktop, this manual does not describe the key-
board shortcuts that you can use to navigate all of the different applications. However, the basic keyboard shortcuts
are common to all applications. Access keys also provide an efficient way to navigate an application from the key-
board. An access key is identified by an underlined letter on a menu or control. In some cases, you must press Alt in
combination with the access key to perform an action.

The following table lists the essential keyboard shortcuts that you can use to navigate applications.

Keys Function

F10 Open the first menu on the application menubar.

Alt + access key Open the menu that is associated with the access key.

access keys Select the menu item that is associated with the access key.

left arrow and right arrow Switch focus between the menus on the menubar.

up arrow and down arrow Move focus into a menu.

Esc Close the open menus and give focus to the control that had fo-
cus before the menubar.

Ctrl-O Open the file selector dialog.

Ctrl-S Open the Save dialog.

Ctrl-L Open a Location dialog to enable you to type the name of the
file that you want to open or save.

Essential Keyboard Shortcuts for Navigating Dialogs
The following table lists the essential keyboard shortcuts that you can use to navigate dialogs.

Keys Function
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Keys Function

Alt-access key Activate or select a control.

Tab Give focus to the next control.

Ctrl-Page Up If a tab name has focus, move to the next tabbed section of the
dialog.

Ctrl-Page Down When a tab name has focus, move to the previous tabbed section
of the dialog.

Esc Close the dialog.

Return Perform the default action for the dialog. The default action is
usually to apply the changes and close the dialog.

Navigating the File Manager
By default, the file manager operates in Spatial mode. This mode uses separate windows for each folder. A separate
mode, called Browser mode, exists that uses the same window for each folder.

For more information about different modes for the file manager, see the user guide
[ghelp:user-guide?nautilus-presentation].

To Navigate a Folder
The following table describes the keyboard shortcuts that enable you to navigate folders in the file manager.

Keys Function

arrow keys Select the next or previous file or folder in the direction of the
arrow key.

Ctrl + arrow keys Give focus to the next or previous file or folder but do not select
the item. This allows multiple files to be selected.

spacebar Open the focused file or folder.

Ctrl + spacebar Select the item that currently has focus.

A sequence of characters that matches the first n
characters of a filename.

Select the first file or folder that starts with the specified se-
quence of characters.

Home Select the first file or folder within the current folder.

End Select the last file or folder within the current folder.

backspace Open the current folder's parent folder.
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Keys Function

To Navigate Browser Window Components
When operating in browser mode, the file manager window contains several components and there are different key-
board shortcuts defined to navigate each component.

The following table describes the keyboard shortcuts that enable you to navigate between the components.

Keys Function

F6 Switch focus between the side pane and the view pane.

Shift-F10 Open the side pane popup menu.

Navigating Help Content in Caret Navigation
Mode
The following table describes how to navigate HTML-based help content in caret navigation mode in the Yelp help
browser. Caret navigation is a mode of operation in an application which enables you to use the keyboard to select
text.

Keys Function

F7 Switch to caret navigation mode.

left arrow Move one character to the left.

right arrow Move one character to the right.

up arrow Move up one line.

down arrow Move down one line.

Ctrl + left arrow Move to the beginning of the previous word.

Ctrl + right arrow Move to the end of the next word.

Page Up Scroll up one page of content.

Page Down Scroll down one page of content.

Home Move to the beginning of the current line.

End Move to the end of the current line.

Shift + arrow keys Move from the current position to the destination position and
select all text between the two positions.
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Keys Function

Tab Move focus to the next focusable control.

Shift-Tab Move focus to the previous focusable control.

Enter Activate a button or submit a form.

Navigating Standard Elements and Controls
The following sections describe how to navigate and use standard user interface elements and controls from the key-
board.

To Navigate Menus
The following table lists the keyboard shortcuts that you can use to navigate menus.

Keys Function

up arrow and down arrow Give focus to the next or previous menu item on a menu.

right arrow If the menu item that has focus is a submenu, open the submenu
and give focus to the first menu item on the submenu.

If the menu item that has focus is not a submenu, open the next
menu on the menubar.

left arrow If the menu item that has focus is a submenu item, switch the fo-
cus back to the submenu.

If the menu item that has focus is not a submenu item, open the
previous menu on the menubar.

Return Select the focused menu item and close the open menus.

access key Select the menu item that is associated with the access key and
close the open menus.

spacebar Select the focused menu item and close the open menus except
when the menu item is a check box or radio button. If the menu
item is a check box or radio button, the menu does not close.

Esc Close the open menus.

To Navigate Buttons
A button is a control that you use to start an action. Most buttons are rectangular and contain a text label.

Figure 3.1. Sample Button
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The following table lists the keyboard shortcuts that you can use to navigate buttons.

Keys Function

spacebar Activate the button that has focus. This is the equivalent of
clicking on the button.

Return Activate the button that has focus or, if no button has focus, per-
form the default action for the dialog.

To Navigate Radio Buttons
A radio button is a control that you use to select one of several mutually-exclusive options.

Figure 3.2. Sample Radio Button

The following table lists the keyboard shortcuts that you can use to navigate a set of radio buttons.

Keys Function

arrow keys Select the next or previous radio button and deselect the other
radio buttons in the group.

To Navigate Check Boxes
A check box is a control that you use to select or deselect an option.

Figure 3.3. Sample Check Box

The following table lists the keyboard shortcuts that you can use to navigate a check box.

Keys Function

spacebar Select or deselect the check box.
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To Navigate Text Boxes
Text boxes are controls in which you type text.

Figure 3.4. Sample Single Line Text Box

The following table lists the keyboard shortcuts that you can use to navigate a single line text box.

Keys Function

left arrow Position the cursor one character to the left.

right arrow Position the cursor one character to the right.

Ctrl-left arrow Position the cursor at the start of the current word. Press-
and-hold Ctrl and continue to press left arrow to position the
cursor at the start of the previous word.

Ctrl-right arrow Position the cursor at the end of the current word. Press-
and-hold Ctrl and continue to press right arrow to position the
cursor at the end of the next word.

Home Position the cursor at the start of the line.

End Position the cursor at the end of the line.

Shift-left arrow or right arrow Select one character at a time to the left or right of the cursor.

Shift-Ctrl-left arrow or right arrow Select one word at a time to the left or right of the cursor.

Shift-Home Select all text to the left of the cursor.

Shift-End Select all text to the right of the cursor.

Ctrl-A Select all text in the text box.

In addition to the keyboard shortcuts listed in the previous table, use the keyboard shortcuts in the following table to
navigate multi-line text boxes.

Keys Function

Page Up Position the cursor at the top of the current view. Press Page Up
again to position the cursor at the top of the previous view.

Page Down Position the cursor at the end of the current view. Press Page
Down again to position the cursor at the end of the previous
view.
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Keys Function

Ctrl-up arrow Position the cursor at the start of the current paragraph. Press-
and-hold Ctrl and continue to press the up arrow key to posi-
tion the cursor at the start of the previous paragraph.

Ctrl-down arrow Position the cursor at the end of the current paragraph. Press-
and-hold Ctrl and continue to press the down arrow key to pos-
ition the cursor at the end of the next paragraph.

Ctrl-Page Up Position the cursor one view width to the left.

Ctrl-Page Down Position the cursor one view width to the right.

Ctrl-Home Position the cursor at the start of the text box.

Ctrl-End Position the cursor at the end of the text box.

Ctrl-Tab Give focus to the next control on the dialog.

Shift-Page Up Select the text to the start of the current view. Press-and-hold
Shift and continue to press Page Up to extend the selection to
the start of the previous view.

Shift-Page Down Select the text to the end of the current view. Press-and-hold
Shift and continue to press Page Down to extend the selection
to the end of the next view.

Shift-Home Select the text to the start of the line.

Shift-End Select the text to the end of the line.

Shift-Ctrl-up arrow Select the text to the start of the paragraph, then to the start of
the previous paragraph.

Shift-Ctrl-down arrow Select the text to the end of the paragraph, then to the end of the
next paragraph.

Shift-Ctrl-Home Select the text to the start of the text box.

Shift-Ctrl-End Select the text to the end of the text box.

To Navigate Spin Boxes
A spin box is a control that allows you to type a numeric value or select a value from a list of all possible values.

Figure 3.5. Sample Spin Box
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The keyboard shortcuts that you use to navigate the text box area of a spin box are listed in the section called “To
Navigate Text Boxes”. The following table lists the keyboard shortcuts that you can use to navigate the up and down
arrows in the spin box.

Keys Function

up arrow or down arrow Increase or decrease the value of the spin box by a small
amount.

Page Up or Page Down Increase or decrease the value of the spin box by a large amount.

To Navigate Drop-Down Lists
A drop-down list is a control that you use to select one of several available items. The drop-down list contains a but-
ton that you use to display the available items.

Figure 3.6. Sample Drop-Down List

The following table lists the keyboard shortcuts that you can use to navigate a drop-down list.

Keys Function

spacebar This key performs one of the following functions:

• If the drop-down list is not open, this key opens the drop-
down list.

• If the drop-down list is open, this key accepts the current se-
lection and closes the list.

up arrow Select the previous list item.

down arrow Select the next list item.

Esc Close the list without changing the selection.

To Navigate Drop-Down Combination Boxes
A drop-down combination box is a text box with a drop-down list attached.

Figure 3.7. Sample Drop-Down Combination Box
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When the text box has focus, use the keyboard shortcuts that are listed in the section called “To Navigate Text
Boxes” to navigate the text box area. When the text box has focus, you can also use the keyboard shortcuts in the
following table to navigate the drop-down list area.

Keys Function

up arrow Select the previous item from the drop-down list without dis-
playing the list.

down arrow Select the next item from the drop-down list without displaying
the list.

Ctrl-down arrow (Solaris only) Open the drop-down list.

When the drop-down list has focus, you can use the keyboard shortcuts that are listed in the following table to navig-
ate the drop-down list.

Keys Function

up arrow Select the previous list item.

down arrow Select the next list item.

Home Select the first item on the list.

End Select the last item on the list.

Page Up Select the item at the top of the current list view.

Page Down Select the item at the bottom of the current list view.

spacebar Accept the current selection and close the drop-down list.

Ctrl-Page Up Scroll to the left of the list, if required.

Ctrl-Page Down Scroll to the right of the list, if required.

To Navigate Sliders
A slider is a control that you use to set a value in a continuous range of values.

Figure 3.8. Sample Slider

The following table describes the keyboard shortcuts that you can use to navigate a slider.
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Keys Function

left arrow or up arrow Move the slider left or up by a small amount.

right arrow or down arrow Move the slider right or down by a small amount.

Page Up Move the slider left or up a large amount.

Page Down Move the slider right or down a small amount.

Home Move the slider to the maximum value.

End Move the slider to the minimum value.

To Navigate Tabbed Sections

Figure 3.9. Sample Dialog with Tabbed Sections
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Windows and dialogs are sometimes divided into logical sections that are displayed one section at a time on the win-
dow or dialog. The divisions are called tabbed sections that are identified by a tab with a text label.

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dia-
log when a tab name has focus.

Keys Function

left arrow Give focus to the previous tabbed section.

right arrow Give focus to the next tabbed section.

Tab orCtrl-down arrow Give focus to the first control on the active tabbed section.

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dia-
log when a control on a tabbed section has focus.

Keys Function

Ctrl-Page Up or Ctrl-Alt-Page Up Give focus to the previous tabbed section.

This keyboard shortcut does not work if the focused control uses
Ctrl-Page Up for another purpose.

Ctrl-Page Down or Ctrl-Alt-Page Down Give focus to the next tabbed section.

This keyboard shortcut does not work if the focused control uses
Ctrl-Page Down for another purpose.

Ctrl-Tab Give focus to the next control outside the tabbed sections.

To Navigate Lists
The following table lists the keyboard shortcuts that you can use to navigate multi-column lists when a column
header has focus.

Keys Function

left arrow or right arrow Give focus to the previous or next column header.

spacebar Activate the header. This action usually sorts the list by the
column header.

Tab Give focus to the list contents.

The following table lists the keyboard shortcuts that you can use to navigate lists when the contents of the list has
focus.

Keys Function
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Keys Function

arrow keys Select the next or previous row or column.

Page Up Select the top row of the list contents that are in view. Press
Page Up again to select the top row of the previous view.

Page Down Select the bottom row of the list contents that are in view. Press
Page Down again to select the bottom row of the next view.

Home Select the first row in the list.

End Select the last row in the list.

Shift + arrow keys For lists that support multi-line selections, add the next or previ-
ous row or column to the current selection.

For lists that only allow single line selections, select the next or
previous row or column.

Shift-Page Up Select all the rows between the current selection and the top row
of the view.

Shift-Page Down Select all the rows between the current selection and the bottom
row of the view.

Shift-Home Select all the rows between the current selection and the first
row in the list.

Shift-End Select all the rows between the current selection and the last row
in the list.

Ctrl + arrow keys Give focus to the next row or column but do not extend the se-
lection. Further items can be selected by pressing the spacebar

Ctrl-Page Up Give focus to the top row in the view but do not extend the se-
lection.

Ctrl-Page Down Give focus to the bottom row in the view but do not extend the
selection.

Ctrl-Home Give focus to the first row in the list but do not extend the selec-
tion.

Ctrl-End Give focus to the last row in the list but do not extend the selec-
tion.

Return Activate the item.

Ctrl-A For lists that support multiline selections, select all rows in the
list.

Shift-Tab Give focus to the column header, if applicable.
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To Navigate Trees
A tree is a user interface control that contains sections that you can expand and collapse. A tree usually represents a
hierarchical structure.

Figure 3.10. Sample Tree Structure

To navigate trees, you can use the same keyboard shortcuts that are listed in the section called “To Navigate Lists”.
In addition, the following table lists the keyboard shortcuts you can use for the tree items.

Keys Function

+ (plus) Expand the focused item.

- (minus) Collapse the focused item.

Back Space Select the parent item.

Ctrl-F Display a search dialog if the tree supports searching. You can
type the name of the tree item that you want to find.

Customizing Your Keyboard Shortcuts
Use the Keyboard Shortcuts preference tool to display the default keyboard shortcuts that you use to navigate the
GNOME Desktop. You can customize the default keyboard shortcuts to meet your requirements. You can also cre-
ate hot keys. Hot keys are keyboard shortcuts that start applications.

To start the Keyboard Shortcuts preference tool, choose Desktop→Preferences→Keyboard Shortcuts. The Desktop
shortcuts table lists the keyboard shortcut that is associated with each action.

To Customize Keyboard Shortcuts on Solaris Systems
To customize a keyboard shortcut on a Solaris system, perform the following steps:
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1. Click on the action for which you want to customize the keyboard shortcut. The row is highlighted.

2. Click on the keyboard shortcut in the Shortcut column. The text “Type a new accelerator, or press Backspace to
clear” is displayed in the Shortcut column.

3. Press the keys that you want to associate with the action. The new keyboard shortcut is displayed in the Short-
cut column.

To disable a keyboard shortcut, perform the following steps:

1. Click on the action for which you want to disable the keyboard shortcut. The row is highlighted.

2. Click on the keyboard shortcut in the Shortcut column. The text “Type a new accelerator, or press Backspace to
clear” is displayed in the Shortcut column.

3. Press Back Space. The keyboard shortcut is disabled.

To Customize Keyboard Shortcuts on Linux Systems
To customize a keyboard shortcut on a Linux system, perform the following steps:

1. Click on the action for which you want to customize the keyboard shortcut. The row is highlighted and the text
“Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.

2. Press the keys that you want to associate with the action. The new keyboard shortcut is displayed in the Short-
cut column.

To disable a keyboard shortcut, perform the following steps:

1. Click on the action for which you want to disable the keyboard shortcut. The row is highlighted and the text
“Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.

2. Press Back Space. The keyboard shortcut is disabled.
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This chapter describes the methods you can use to change the appearance of the GNOME Desktop to enhance the
accessibility of the desktop for users with visual impairments.

Customization Options
There are a number of methods to enable you to customize the appearance of the GNOME Desktop to suit your spe-
cific needs, as follows:

Themes
Themes are the most effective way to change the appearance of the desktop in a consistent manner. See the sec-
tion called “Using Themes to Customize the Desktop” for more information about themes and how to use
themes to achieve the type of desktop environment that you require.

Desktop and application-specific configuration settings
You can customize different components of the desktop individually to achieve the display settings that you re-
quire. You can configure the desktop and applications in addition to using themes or as an alternative to using
themes. See the section called “Customizing Specific Components of the Desktop” for more information.

The following table summarizes the changes that you can make to the GNOME Desktop and where you can make
the changes. This guide does not provide detailed instructions about how to customize the desktop. For detailed in-
structions about how to use the customization tools that the desktop provides, refer to the Help for each tool or to the
User Guide [ghelp:user-guide?prefs].

Table 4.1. Quick Reference to Customizing the Appearance of the Desktop

To change the... Use...

Overall appearance of the desktop to use high contrast colors, low contrast col-
ors, or large print.

The Theme preference tool.

Appearance of the desktop background only. The Desktop Background prefer-
ence tool and the file manager
Backgrounds and Emblems menu
item.

Font displayed on the desktop background and in all desktop applications. The Font preference tool.

Default font settings of the Text Editor, Terminal or Help application. By default, these applications use
the default application font that is
specified in the Font preference
tool but can be overridden in the
Preferences dialog for the applica-
tion.

Using Themes to Customize the Desktop
This section describes how to use themes to customize the appearance of the GNOME Desktop.

Introduction to Themes
A theme is a group of coordinated settings that specifies how a desktop component or a group of desktop compon-
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ents appears. You can use themes to modify and control the appearance of the desktop in a consistent manner. When
you apply a theme, the system modifies many desktop components simultaneously to achieve the desired effect. For
example, if you apply a theme that increases the font size across the desktop, the theme also modifies the size of
panels and icons on the desktop for optimum compatibility with the font size.

A theme contains settings that affect different parts of the desktop as follows:

Controls
The controls setting for a theme determines the visual appearance of all windows, applications, panels, and pan-
el applications. The controls setting also determines the visual appearance of the GNOME-compliant interface
items that appear on windows, applications, panels, and panel applications, such as menus, icons, and buttons.
Some of the controls options that are available in the desktop are designed for special accessibility needs.

Window border
The window frame setting determines the appearance of the border around windows only.

Icon
The icon setting determines the appearance of icons on panels and on the desktop background.

To Choose a Theme
To choose a theme, perform the following steps:

1. Choose Desktop→Preferences→Theme. The themes are listed on the left side of the Theme Preferences dialog.

2. Click on a theme in the list box to choose a new theme. The system automatically applies the theme to the
desktop.

There are several themes available that suit different accessibility needs, as described in the following table:

Table 4.2. Themes Designed for Accessibility Requirements

Theme Name Description

High Contrast Provides dark text on a light background using high con-
trast colors.

High Contrast Inverse Provides light text on a dark background using high con-
trast colors.

Large Print This theme suggests an increased font size of 18pt. The
background and foreground colors are the same as those
specified by the Default desktop theme. To apply the sug-
gested font, click on the Apply Font button.

High Contrast Large Print This theme suggests an increased font size of 18pt using
dark text on a light background. To apply the suggested
font, click on the Apply Font button.

High Contrast Large Print Inverse This theme suggests an increased font size of 18pt using
light text on a dark background. To apply the suggested
font, click on the Apply Font button.

To view the controls, window frame, and icon settings that are associated with a theme, select a theme in the Theme
Preferences dialog, then click on the Theme Details button. The Theme Details dialog contains a tabbed section for
each setting category. Each tabbed section lists the options that are available and the current setting for the theme is
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highlighted.

To Modify the Controls Setting for a Theme
To modify the controls setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.

2. Click on the Theme Details button. The Theme Details dialog is displayed.

3. Click on the Controls tab to display the controls options that are available.

4. Select the controls option that you want to associate with the current theme from the list box, then click Close.
The following table lists the controls options that are suitable for accessibility needs.

Table 4.3. Controls Options Designed for Accessibility Requirements

Control Option Description

HighContrast Provides dark text on a light background using high con-
trast colors.

HighContrastInverse Provides light text on a dark background using high con-
trast colors.

LowContrast Uses low contrast colors for the background and fore-
ground text.

LargePrint Increases the size of controls to accommodate larger
fonts. To increase the font size, you must use the Font
preference tool. The background and foreground colors
are the same as those specified by the Default desktop
theme.

HighContrastLargePrint Provides dark text on a light background using high con-
trast colors. Increases the size of controls to accommod-
ate larger fonts. To increase the font size, you must use
the Font preference tool.

HighContrastLargePrintInverse Provides light text on a dark background using high con-
trast colors. Increases the size of controls to accommod-
ate larger fonts. To increase the font size, you must use
the Font preference tool.

LowContrastLargePrint Uses low contrast colors for the background and fore-
ground text. Increases the size of controls to accommod-
ate larger fonts. To increase the font size, you must use
the Font preference tool.

To Modify the Window Border Setting for a Theme
To modify the window border setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.
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2. Click on the Theme Details button. The Theme Details dialog is displayed.

3. Click on the Window Border tab to display the window frame options that are available.

4. Select the window frame option that you want to associate with the current theme from the list box, then click
Close. The Atlanta option is an accessible option.

To Modify the Icon Setting for a Theme
To modify the icon setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.

2. Click on the Theme Details button. The Theme Details dialog is displayed.

3. Click on the Icons tab to display the icon options that are available.

4. Select the icon option that you want to associate with the theme from the list box, then click Close. The follow-
ing table lists the icon options that are suitable for accessibility needs.

Table 4.4. Icon Options Designed for Accessibility Requirements

Icon Option Description

HighContrast Provides dark on light icons using high contrast colors.

HighContrastInverse Provides light on dark icons using high contrast colors.

LowContrast Uses low contrast colors for the background and fore-
ground text.

To Create Your Own Themes
For information about how to create your own themes, see the System Administration Guide
[ghelp:system-admin-guide?themes-0].

Customizing Specific Components of the
Desktop
This section describes how to customize specific components of the desktop individually.

To Customize the Desktop Background
The themes do not affect the desktop background. Therefore to modify the desktop background to complement your
desktop, you must customize the desktop background separately using the Desktop Background preference tool. To
start the Desktop Background preference tool,choose Desktop→Preferences→Desktop Background.

To Customize Desktop Background Objects
The size of the icons that are displayed on the desktop background is controlled by the File Management preference
tool. To change the size of the icons, perform the following steps:

1. From the File Manager window, choose the Edit→Preferences menu item.
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2. Select the Views tabbed section.

3. In the Icon View Defaults group, select the zoom level that you require in the Default zoom level drop-down
list.

To Customize Fonts
This section describes how to customize the font settings for the desktop and frequently-used applications.

If you have difficulty with the default font type and font size that is used on the desktop and desktop background,
you can customize the font settings to suit your needs.

You can specify individual font settings for the following desktop components and applications:

• Entire desktop excluding the desktop background

• Desktop background only

• Terminal

• Text editor

• Help

• Web Browser

To Customize the Desktop Fonts

The Font preference tool allows you to specify the default fonts for the desktop.

To start the Font preference tool, choose Desktop→Preferences→Font. The Font Preferences dialog contains the fol-
lowing options:

Application font
Click on this button to select a default font to use for the text that is displayed on the desktop, including the text
displayed on the windows and dialogs associated with GNOME-compliant applications and panel applications.

If you use the Theme preference tool to select a theme and you click on the Apply Font button, the
font that is associated with the theme overrides the font that you select using the Font preference
tool.

Document font
Click on this button to select a font to use for displaying documents.

Desktop font
Click on this button to select a font to use for the text that is displayed on the desktop background only.

Window title font
Click on this button to select a font to use for the text that is displayed in titlebars of your windows.

Fixed width font
Click on this button to select a font to use for editing documents.

Font rendering
To specify how to render fonts on the desktop, select one of the following options:

• Monochrome

• Best shapes

• Best contrast

• Subpixel smoothing
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If you use large fonts, you may need to change the size of panes in applications that use panes such as,
the file manager and the Help browser.

For more information about the Font preference tool, see the User Guide [ghelp:user-guide?prefs-font].

To Customize Application Fonts

By default, GNOME applications use the default font specified in the Font preference tool. Some applications allow
this default font to be customized. These applications are:

• Help Browser [ghelp:user-guide#yelp]

• Text Editor [ghelp:gedit?gedit-prefs-fontsandcolors]

• Terminal [ghelp:gnome-terminal#gnome-terminal-prefs-general]

• Web Browser [ghelp:epiphany#ephy-customize]

Meeting Specific Accessibility Needs
The following sections summarize the steps you need to take to improve the accessibility of the desktop in a particu-
lar area.

To Achieve a High or Low Contrast Desktop
To achieve a high or low contrast desktop, perform the following steps:

1. Use the Theme preference tool to select the high contrast or low contrast desktop theme that you require.

2. Use the Desktop Background preference tool to customize your desktop background as follows:

• Set the Desktop Wallpaper to No Wallpaper.

• Set the Desktop Colors to Solid Color.

• Select a background color that suits your needs.

3. In the Terminal application, ensure that the Use colors from system theme option is selected in the Colors
tabbed section of the Editing Profile dialog.

4. In the gedit application, ensure that the Use default theme colors option is selected in the Fonts & Colors
tabbed section of the Preferences dialog.

To Achieve a Large Print Desktop
To achieve a large print desktop, perform the following steps:

1. Use the Theme preference tool to select the Large Print theme.

2. Click on the Apply Font button to increase the size of the font that is used on the desktop and on window
frames.

3. Use the Desktop font option in the Font preference tool to increase the font that is displayed on desktop back-
ground objects.

4. Increase the font size that is used to display the contents of the Terminal application window.

5. If the Use default theme font option is selected in the gedit Preferences dialog, gedit uses the font size that is
specified in the large print theme that you selected. However, if the Use default theme font option is not selec-
ted, increase the font size that is used to display the contents of the gedit text editor window. See the gedit
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manual [ghelp:gedit?gedit-prefs-fontsandcolors] for more information.

6. If you use applications that use panes, such as the file manager and the Help browser, you may need to change
the size of panes to accommodate the large print. See the online help for the appropriate application for more
information.
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The GNOME Desktop contains the following applications to enable users with a physical disability to use the
desktop:

• On-Screen Keyboard

• Screen Reader and Magnifier

Before you can use the On-Screen Keyboard and Screen Reader and Magnifier on Solaris systems, you
must follow the steps outlined in the section called “Enabling XKB on Solaris Systems” of this guide.

On-Screen Keyboard
The On-Screen Keyboard application displays virtual keyboards on your desktop. You can use the standard mouse
pointer or alternative pointing device to operate the virtual keyboards. On-Screen Keyboard displays the following
types of keyboards:

• Compose keyboards that enable you to compose text. To type alphanumeric characters, you select the characters
on the compose keyboard.

• Dynamic keyboards that On-Screen Keyboard generates to reflect the applications that are currently running on
the desktop. For example, On-Screen Keyboard generates keyboards that contain keys to represent the applica-
tions that are running on your desktop or the menus that are contained in an application.

To start On-Screen Keyboard, choose Applications→Accessibility→On-Screen Keyboard. For more information
about the On-Screen Keyboard application, see the Help for On-Screen Keyboard [ghelp:gok].

Maximizing Application Windows for On-Screen Keyboard
Users
If you are an On-Screen Keyboard user, you cannot use any application in Full Screen mode because the application
window obscures the On-Screen Keyboard display.

To resize the window for use with the On-Screen Keyboard application, perform the following steps:

1. Do not enable the Full Screen mode in the application.

2. Give focus to the application window.

3. Press F10 to maximize the application.

Screen Reader and Magnifier
The Screen Reader and Magnifier application enables users with limited vision, or no vision, to use the GNOME
Desktop and associated applications. Screen Reader and Magnifier provides the following functionality:

• Screen reader

The screen reader enables non-visual access to standard applications in the GNOME Desktop, using speech and
Braille output.

• Magnifier

The magnifier provides automated focus tracking and fullscreen magnification to aid low-vision users.
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To start Screen Reader and Magnifier, choose Applications→Accessibility→Screen Reader and Magnifier. For
more information about the application, see the online Help for Screen Reader and Magnifier [ghelp:gnopernicus].

Disabling the Screensaver
Before you use On-Screen Keyboard or Screen Reader and Magnifier, you must disable the screensaver. To disable
the screensaver, perform the following steps:

1. Choose Desktop→Preferences→Screensaver.

2. Deselect the Activate screensaver when session is idle checkbox.
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Appendix A. System Administration
This appendix describes some tasks that a system administrator needs to perform to enable accessible login and to
facilitate the use of the assistive technologies that are available in the GNOME Desktop.

Configuring the Desktop for Accessible Login
The GNOME Desktop includes an Accessible Login feature. The Accessible Login feature enables users to:

• Log in to the desktop even if the user cannot easily use the screen, mouse, or keyboard in the usual way.

• Launch assistive technologies at login time by associating a user action with an assistive technology application.
The user can perform the user action from the standard keyboard, or from a keyboard, pointing device, or switch
device that is attached to the USB or PS/2 mouse port. These user actions are called gestures.

• Change the visual appearance of the login dialog before the user logs in, for example, to use a high contrast
theme for better visibility.

To Enable Accessible Login
To enable the Accessible Login feature for the GNOME Desktop, you must configure the desktop to use the
GNOME Display Manager (GDM) as the login manager. GDM is the default login manager on Linux systems but
not on Solaris systems, therefore the instructions to enable Accessible Login differ depending on the platform you
are using.

To Enable and Configure GDM on Solaris Systems

To enable and configure GDM as the login manager on Solaris systems, perform the following steps:

1. Log in as the root user.

2. Open the file /etc/X11/gdm/gdm.conf.

3. Search the file for the following line:

#AddGtkModules=false

and replace the line with the following:

AddGtkModules=true

This step enables the GtkModules.

4. Search the file for the following line:

#GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

and delete the # from the start of the line so that the line reads:

GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

The above lines must be displayed as single lines in the gdm.conf file without line breaks. The
formatting of this guide may display the lines over two lines.

This step loads all of the GtkModules to enable assistive technologies such as On-Screen Keyboard and Screen
Reader and Magnifier. You can edit the line above further to load only the GtkModules that you require to sup-
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port the user base. For example:

• If you need to use the Screen Reader and Magnifier, include gail and atk-bridge.

• If you need to use a pointing device without buttons or switches, include gail, atk-bridge,
anddwellmouselistener.

• If you use pointing devices with switches, alternative physical keyboards, or switch and button devices, in-
clude keymouselistener.

• On-Screen Keyboard can operate without gail and atk-bridge but with a reduced feature set.

For optimum accessibility, include gail and atk-bridge.

5. Save the /etc/X11/gdm/gdm.conf file.

6. Enter the following command to stop the dtlogin manager:

/usr/dt/bin/dtconfig -d

7. Enter the following commands to configure GDM as the login manager:

svccfg import /var/svc/manifest/application/gdm2-login.xml

svcadm enable application/gdm2-login

If you make any changes to the /etc/X11/gdm/gdm.conf file after you enable GDM, you
can execute the following command to restart GDM and activate the changes:

gdm-restart

8. Edit the file /etc/passwd to append the following to the end of the gdm line:

:/etc/X11/gdm/home

9. Create the /etc/X11/gdm/home directory and assign ownership of the directory to the gdm user.

10. Restart your system.

To Configure GDM on Linux Systems

To configure GDM on Linux systems, perform the following steps:

1. Log in as the root user.

2. Open the file /etc/X11/gdm/gdm.conf.

3. Search the file for the following line:

#AddGtkModules=false

and replace the line with the following:

AddGtkModules=true

This step enables the GtkModules.

4. Search the file for the following line:

#GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

and delete the # from the start of the line so that the line reads:
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GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

The above lines must be displayed as single lines in the gdm.conf file without line breaks. The
formatting of this guide may display the lines over two lines.

This step loads all of the GtkModules to enable assistive technologies such as On-Screen Keyboard and Screen
Reader and Magnifier. You can edit the line above further to load only the GtkModules that you require to sup-
port the user base. For example:

• If you need to use the Screen Reader and Magnifier, include gail and atk-bridge.

• If you need to use a pointing device without buttons or switches, include gail, atk-bridge, and
dwellmouselistener.

• If you use pointing devices with switches, alternative physical keyboards, or switch and button devices, in-
clude keymouselistener.

• On-Screen Keyboard can operate without gail and atk-bridge but with a reduced feature set.

For optimum accessibility, include gail and atk-bridge.

5. Save the /etc/X11/gdm/gdm.conf file.

If you make any changes to the /etc/X11/gdm/gdm.conf file after you enable GDM, you
can execute the following command to restart GDM and activate the changes:

gdm-restart

6. Edit the file /etc/group and append the following to the audio line:

,gdm

This step ensures that speech works with GDM.

7. Restart your system.

To Start Assistive Technologies at Login
If you load the keymouselistener and dwellmouselistener GtkModules in the GDM configuration file,
you can assign user actions to launch specific assistive technologies at login time. These user actions are called ges-
tures. The gesture associations are contained in the following GDM configuration files:

• /etc/X11/gdm/modules/AccessKeyMouseEvents

• /etc/X11/gdm/modules/AccessDwellMouseEvents

If you modify these files, you must restart your system before the changes take effect.

The following sections contain examples of the gestures that you can add to the GDM configuration files.

The gestures must be contained in a single line in the AccessKeyMouseEvents file without line
breaks. The formatting of this guide might display the examples in the following sections over two
lines.
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To Start Screen Reader Using a Keyboard Shortcut

Edit the AccessKeyMouseEvents file to associate keyboard shortcuts with assistive technologies. For example,
the following line enables you to press-and-hold Ctrl-S for one second to start Screen Reader and Magnifier in
speech and Braille mode:

Solaris:

<Control>s 1 1000 10000 /usr/sfw/bin/srcore --login --disable-magnifier -
-enable-speech --enable-braille

Linux:

<Control>s 1 1000 10000 srcore --login --disable-magnifier --enable-speech -
-enable-braille

To Start Magnifier Using a Keyboard Shortcut

Edit the AccessKeyMouseEvents file to associate keyboard shortcuts with assistive technologies. For example,
the following line enables you to press-and-hold Ctrl-M for one second to start Screen Reader and Magnifier in
magnifier mode:

Solaris:

<Control>m 1 1000 10000 /usr/sfw/bin/srcore --login --enable-magnifier -
-disable-speech

Linux:

<Control>m 1 1000 10000 srcore --login --enable-magnifier --disable-speech

To Start On-Screen Keyboard Using a Switch or Button Gesture

Edit the AccessKeyMouseEvents file to associate switch, key, or button gestures with assistive technologies.
Since the primary input device for many On-Screen Keyboard users is a switch or button, this is a good way to en-
able users to start On-Screen Keyboard at login time.

If there is a tendency for a user to start an application unintentionally, you can associate the gestures with multiple
switch presses or minimum durations. For example, the following line starts On-Screen Keyboard in inverse scan-
ning mode when the user presses the switch that is defined as Switch 2 three times within two seconds, for a minim-
um of 100 milliseconds for each press:

Solaris:

<Switch2>3 100 2000 /usr/sfw/bin/gok --login --accessmethod=inversescanning -
-scan-action=switch1 --select-action=switch2

Linux:

<Switch2>3 100 2000 gok --login --accessmethod=inversescanning -
-scan-action=switch1 --select-action=switch2

Users who use single switches may prefer to start On-Screen Keyboard in automatic scanning mode. The following
line starts On-Screen Keyboard in automatic scanning mode when the user presses the switch on an alternative ac-
cess device for more than four seconds:

Solaris:

<Switch>1 4000 5000 /usr/sfw/bin/gok --login --accessmethod=automaticscanning
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--scan-action=switch1 --select-action=switch1

Linux:

<Switch>1 4000 5000 gok --login --accessmethod=automaticscanning -
-scan-action=switch1 --select-action=switch1

For information about the On-Screen Keyboard operating modes, see the online Help for On-Screen Keyboard.

To Start On-Screen Keyboard Using a Motion-only Gesture

You can define gestures that involve only the motion of a pointing device such as a mouse, or an alternative pointing
device, such as a head pointer or trackball. The syntax of the gesture does not change depending on whether you are
using a mouse or an alternative pointing device. Edit the AccessKeyMouseEvents file to associate motion ges-
tures with assistive technologies.

If the dwellmouselistener GtkModule is loaded, alternative pointing devices are temporarily latched to the
core pointer. This means that if the user moves the alternative pointing device, the onscreen pointer moves.

For example, the following line starts On-Screen Keyboard in dwell mode when the user moves the onscreen pointer
from inside the login dialog through the top edge, back into the dialog through the top edge, out of the dialog
through the left edge, back into the dialog through the left edge, and similarly through the bottom and right edges of
the dialog in a cross pattern:

Solaris:

TTLLBBRR O 10000 /usr/sfw/bin/gok --login --access-method=dwellselection -
-input-device=MOUSE[3]

Linux:

TTLLBBRR O 10000 gok --login --access-method=dwellselection -
-input-device=MOUSE[3]

Note that the --input-device parameter specified in the gesture must match the name of the extended user in-
put device, such as a head pointer or trackball, as specified in /etc/X11/XF86Config.

Additional Requirements for Accessible Login
To enable the Accessible Login feature to use alternative pointing devices and switch devices such as sip-and-puff
switches, wheelchair-mounted switches, or trackballs, you might need to modify your X server system configuration
to recognize these devices. You can use most devices that emulate mouse buttons with the Accessible Login feature
and On-Screen Keyboard, including USB single switches and mouse-like pointing devices.

You should not configure an alternative input device to control the primary onscreen pointer. This
might result in undesirable behavior or cause situations from which the user of the alternate input
device cannot recover without using the primary keyboard or mouse. To prevent this problem, please
remove any occurrences of the attributes SendCore or AlwaysCore from any of InputDevice
lines in the X Server configuration file.

Configuring the Java Environment for Accessib-
ility on Solaris Systems
To configure the Java environment on Solaris systems for accessibility, perform the following steps:
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1. Log in as the root user to the base directory of the Java SDK installation.

2. Enter the following command:

cd jre/lib

3. Enter the following command:

ln -s /usr/share/jar/accessibility.properties

4. Enter the following command:

cd ext

5. Enter the following command:

ln -s /usr/share/jar/gnome-java-bridge.jar

Enabling XKB on Solaris Systems
If you are using the desktop for the Solaris operating system on a SPARC platform, you must enable XKB on your
system before you can use the AccessX preference tool, Screen Reader and Magnifier, or On-Screen Keyboard.

XKB is not currently supported on Sun Ray systems.

To enable XKB on a non-Sun Ray Solaris system, perform the following steps:

1. Log in as the root user.

2. Check if the path and file /etc/dt/config/Xservers exists on your system.

3. If the /etc/dt/config directory does not exist, enter the following command:

mkdir -p /etc/dt/config

4. If the Xservers file is not present, enter the following command:

cp /usr/dt/config/Xservers /etc/dt/config/Xservers

5. Open the Xservers file in a text editor and scroll to the end of the file.

6. Append the following to the command line at the end of the file:

+kb

7. Save and close the Xservers file.

8. Enter the following command at a command line:

pkill -HUP dtlogin

9. Open the /etc/X11/gdm/gdm.conf file in a text editor.

10. Scroll towards the end of the file until you see the line [server - standard].

11. Edit the command line in this section to append the following to the end of the line:

+accessx +kb

12. Save and close the gdm.conf file.
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13. Log out of your session and log in again.

14. To verify if XKB is running, execute the following command:

xdpyinfo

then search for XKEYBOARD in the extensions list.

Enabling Full Screen Magnification
The following sections describe the methods to enable full screen magnification.

To Enable Full Screen Magnification Using Two Video Cards
To enable full screen magnification in Screen Reader and Magnifier using two physical video cards, perform the fol-
lowing steps:

1. Configure two video cards as :0.0 and :0.1.

It is not essential that both video cards have the same resolution and bit depth. However, if the
resolutions and bit depths of both cards differ greatly, the apparent magnification factor may dif-
fer slightly from the nominal magnification factor.

2. Choose Applications→Accessibility→Screen Reader and Magnifier.

3. Click on Preferences in the Gnopernicus menu window.

4. Click on Magnifier to open the Magnifier Preferences dialog.

5. Click on the Add/Modify button to display the Zoomer Options dialog.

6. In the Display Screen section, type :0.0 in the Source text box.

7. In the Display Screen section, type :0.1 in the Target text box.

8. Set the Zoomer Placement values to be [0,0,1023,767].

These instructions assume a video resolution of 1024x768.

9. Click Apply and Close to close the Zoomer Options dialog.

The magnified view is displayed on the second display 0.1.

To Enable Full Screen Magnification Using One Video Card
on Linux Systems
To enable full screen magnification on Linux systems using one physical video card and one virtual video card, per-
form the following steps:

1. Open the file /etc/X11/XF86Config.

2. Create a new section at the end of the file as follows:
Section "Device"
Boardname "dummy"
Driver "dummy"
Identifier "dummy"
VendorName "dummy"
EndSection
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3. Copy the Monitor section and paste it at the end of the file.

4. In the new Monitor section, edit the Identifier line as follows:

Identifier "MonitorD"

5. Copy the Screen section and paste it at the end of the file.

6. In the new Screen section, edit the Device, Identifier, and Monitor lines as follows:

Device "dummy"
Identifier "ScreenD"
Monitor "MonitorD"

7. Edit the ServerLayout section to change the Screen line as follows:

Screen "Screen[0]" 0 0

8. Insert the following line in the ServerLayout section:

Screen "Screen[D]" RightOf "Screen[0]"

9. Save the /etc/X11/XF86Config file.

10. Restart the X Server.

11. Start the Screen Reader and Magnifier application.

12. Click on Startup Mode in the Gnopernicus menu window.

13. Select the Magnifier option in the Startup Mode dialog.

14. Click on Preferences in the Gnopernicus menu window.

15. Click on Magnifier to open the Magnifier Preferences dialog.

16. Click on the Add/Modify button to display the Zoomer Options dialog.

17. In the Display Screen section, type :0.1 in the Source text box.

18. In the Zoomer Placement section, set the value of the Left spin box to 0.

19. Click Apply.

The Screen Reader and Magnifier user interface is no longer visible.

20. Log out of your session.

21. Log in to a new session.

22. Enter the following command to start Screen Reader and Magnifier in full screen magnification mode:

gnopernicus -display :0.1

23. When you log out of your session, select the Save current setup option.

Enabling Braille
To enable your system to support Braille output, you must configure the access rights to the serial port to which the
Braille device is connected. The following sections describe the steps that you need to perform depending on your
operating system.

To Enable Braille on Solaris Systems
To configure the serial port to which the Braille device is connected on Solaris systems, perform the following steps:
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1. Log in as the root user.

2. Enter the following command:

chmod 777 /dev/cua/a

3. Enter the following command:

chmod 777 /dev/cua/b

4. Change the permissions to 777 on the devices to which the symbolic links /dev/cua/a and /dev/cua/b
point.

If your system uses /dev/cua/a for system log messages, Braille will not work on that serial port. Use /
dev/cua/b instead.

To Enable Braille on Linux Systems
To configure the serial port to which the Braille device is connected on Linux systems, perform the following steps:

1. Log in as the root user.

2. Enter the following command:

chmod 777 /dev/ttyS0

3. Enter the following command:

chmod 777 /dev/ttyS1

Configuring Alternative Pointer Devices
The following sections describe how to configure your system to use a standard physical mouse and another pointer
device such as a single switch device or head tracker device, and how to configure On-Screen Keyboard to use the
second pointer device.

To Configure Alternative Pointer Devices on Solaris Systems
To configure an alternative pointer device on a Solaris system, perform the following steps:

This procedure does not work on all Solaris platforms.

1. Before you connect the alternative pointer device to your system, enter the following command to list the exist-
ing devices:

ls -l /dev/usb/hid*

2. Connect the alternative pointer device to your system.

3. Enter the following command again to list the new device:

ls -l /dev/usb/hid*

4. Open the file /usr/openwin/server/etc/OWconfig.

5. Add the following lines to the OWconfig file:
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# Sun Mouse module
class="XINPUT" name="IMOUSE2"
dev="/dev/usb/hid2" strmod="usbms"
ddxHandler="ddxSUNWmouse.so.1"
ddxInitFunc="ddxSUNWmouseProc";

where:

• the name option starts with the string IMOUSE but is extended to form a unique string, such as IMOUSE2
or IMOUSE3, depending on the number of existing devices.

• the dev option specifies the device name that you identified in Step 3.

6. Remove the following lines from the OWconfig file:

# Null Mouse module
class="XINPUT" name="NMOUSE"
ddxHandler="ddxSUNWmouse.so.1"
ddxInitFunc="ddxnullmouseProc";

7. Save the /usr/openwin/server/etc/OWconfig file.

8. Restart the X Server.

To Configure Alternative Pointer Devices on Linux Systems
To configure an alternative pointer device on a Linux system, perform the following steps:

1. Before you connect the alternative pointer device to your system, enter the following command to list the exist-
ing devices:

ls -l /dev/usb/hid*

2. Connect the alternative pointer device to your system.

3. Enter the following command again to list the new device:

ls -l /dev/usb/hid*

4. Open the file /etc/X11/XF86Config.

5. Edit the InputDevice section where the Driver value is set to mouse as follows:

• Change the Option Device line to the following:

Option "Device" "/dev/input/mouse0"

• Comment out the Option Protocol line as follows:

#Option "Protocol" "explorerps/2"

If you are not using USB connections for your primary mouse device and other pointer device,
you do not need to carry out this step.

6. Create a new InputDevice section as follows:

Section "InputDevice"
Driver "mouse"
Identifier "Mouse[3]"
Option "Device" "/dev/input/mouse1"
Option "Name" "Autodetection"
Option "Vendor" "Sysp"
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EndSection

If you are not using USB connections for your primary mouse device and other pointer device,
you do not need to carry out this step.

7. Edit the ServerLayout section as follows:

• Change the InputDevice "Mouse[1]" line to the following:

InputDevice "Mouse[1]" "CorePointer"

• Create a new InputDevice line as follows:

InputDevice "Mouse[3]"

• Remove any occurrences of the attributes SendCore or AlwaysCore from any of InputDevice lines.

Ensure that only the device that you are using as the primary mouse device has the "CorePoint-
er" attribute and ensure that the alternate input devices do not have the SendCore or Alway-
sCore attributes.

8. Save the /etc/X11/XF86Config file.

9. Restart the X Server.

To Configure On-Screen Keyboard to Use an Alternative
Pointer Device
To configure the On-Screen Keyboard application to use an alternative pointer device, perform the following steps.

1. Start the On-Screen Keyboard application.

2. Click on GOK in the GOK - main window.

3. Click on Preferences to open the Preferences dialog.

4. Click on the Actions tab.

5. In the Event Source options, select the Other input device option. On-Screen Reader displays the name of the
input device that you configured in the text box next to the Other input device option.

6. Click OK to close the GOK Preferences dialog.
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